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1. UVOD  

Beton je materijal koji se često koristi u građevinarstvu, pa je stoga njegov učinak na 

elektromagnetsko zračenje od velikog interesa zbog široke primjene u zgradama, infrastrukturi te 

urbanim sredinama. Također, beton ima visoku apsorpciju energije zračenja, što može imati 

značajan utjecaj na rad bežičnih komunikacijskih sustava, kao što su mobilne mreže i Wi-Fi. 

Ispitivanje apsorpcije betona pomaže pri optimizaciji dizajna i postavljanju antena te poboljšanju 

dizajna bežičnih komunikacijskih sustava u urbanim sredinama.  U ovom radu se ispituje utjecaj 

betonske prepreke na elektromagnetski val koji prolazi kroz nju. Za antene su odabrani konusni 

dipoli, iz razloga što imaju kružni dijagram zračenja, te nude širok pojas frekvencija što ih čini 

prigodnima za ispitivanje elektromagnetske kompatibilnosti (EMC). 

U ovom završnom radu odradit će se simulacija apsorpcije elektromagnetskog zračenja između 

dvije antene s preprekom u programu Ansys 2022 R1. Apsorpcija zračenja je predstavljena S 

parametrima, kojih ima četiri ukoliko se koriste dvije antene. Za antene se koriste konusni dipoli 

između kojih se nalazi prepreka od armiranog betona. U radu su najprije izvedene simulacije 

parametara samog konusnog dipola u slobodnom prostoru: koeficijent refleksije S11, dijagram 

zračenja antene, odnos stojnih valova VSWR i ulazna impedancija. Nakon toga dodan je još jedan 

konusni dipol te su određeni parametri S12, S21 i S22. Dodana je betonska prepreka između dvaju 

dipola te su simulirani koeficijenti transmisije S12 i S21, te koeficijent refleksije S11. Na kraju su 

dodane željezne šipke različitih dimenzija i debljine u beton kako bi se dobio armirani beton i 

ponovno je simuliran koeficijent transmisije S21, kao i koeficijent refleksije S11.  

Završni rad se sastoji od pet poglavlja. U drugom poglavlju je opisan električni naboj, električno i 

magnetsko polje te su navedene i objašnjene Maxwellove jednadžbe. Ukratko su opisani 

elektromagnetski valovi te je navedena njihova podjela, a također su opisani i radiovalovi. Treće 

poglavlje sadrži teorijski uvod u antene i opis parametara antene, kao i opis konusnog dipola, dok 

su u četvrtom poglavlju kratko opisani S parametri. U petom poglavlju se nalazi opis programa 

Ansys 2022 R1 koji se koristi za simulaciju. Opisan je i rad u programu te su analizirani rezultati 

simulacije. 
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1.1. Zadatak završnog rada 

Zadatak završnog rada je simulacija dva 3D konusna dipola u području od 1 do 2 GHz. Između 

dipola postaviti armirani beton s poznatim svojstvima (μ, ε, σ) te prostornim dimenzijama 600 x 

600 mm, debljine betona 200 mm. Unutar betona postaviti vodljive rešetke 70x70, 100x100 i 

140x140; debljine 8 mm i 10 mm svake. Odrediti koeficijente refleksije (S11, S22) svake antene 

posebno (bez betona). Odrediti koeficijente transmisije (S12 i S21) dvije antene s preprekom između 

njih. 
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2. ELEKTROMAGNETIZAM 

Kroz povijest je bilo poznato da je električni naboj izvor električnog fenomena. Električni naboj 

je temeljno svojstvo čestica koje djeluju jedna na drugu električnim silama. Razlikuju se pozitivno 

i negativno nabijeni električni naboji. Jednako nabijeni naboji se međusobno privlače, dok se 

različito nabijeni naboji odbijaju. Sila kojom se oni privlače ili odbijaju naziva se Coulombova 

sila koja je za dvije točke naboja Q1 i Q2 sa međusobnom udaljenošću r dana formulom: 

 
𝐹 =  

1

4𝜋𝜀0
·
𝑄1𝑄2

𝑟2
 (2-1) 

gdje je 𝜀0 dielektrična konstanta vakuuma koja iznosi 8.854 · 10-12 As/Vm. 

Vrijednost elementarnog naboja se označava sa e te iznosi 1.602 · 10-19. Međutim, količina naboja 

u praksi je toliko velika da se naboj gleda kao kontinuirana količina za koju se pretpostavlja da se 

nalazi u jednoj točki u prostoru. Za izražavanje takvog naboja uvodi se pojam gustoće električnog 

naboja ϱ. Ukupan naboj Q u određenom volumenu V se izražava kao: 

 
𝑄 = ∭ϱ dν

 

𝑉

 (2-2) 

Koncept izravnih sila između udaljenih naboja moguće je zamijeniti konceptom električnog polja 

koje proizlazi iz naboja i djeluje na druge naboje. Jakost električnog polja 𝐸⃗ 1  naboja Q1 promatra 

se u točki u prostoru gdje je smješten Q2. Jakost električnog polja 𝐸⃗ 1 jednaka je omjeru sile 𝐹 2 koja 

djeluje na naboj Q2 i naboja Q2. Smjer vektora jakosti električnog polja 𝐸⃗ 1 jednak je smjeru u 

kojem djeluje sila 𝐹 2. Električno polje se obično vizualizira pomoću električnih silnica koje izlaze 

iz pozitivnih naboja, a ulaze u negativne naboje. 

U prirodi postoje magnetski materijali koji privlače ili odbijaju druge magnetske materijale. 

Između njih se javlja sila zbog međudjelovanja magnetskih polja. Temeljna veličina koja opisuje 

magnetsko polje je magnetska indukcija 𝐵⃗ . Permanentni magneti stvaraju stalno magnetsko polje 

koje je moguće vizualizirati pomoću magnetskih silnica. Mjesto iz kojeg silnice izlaze naziva se 

južni pol, a mjesto gdje silnice ulaze je sjeverni pol. 

Permanentni magneti samo su jedan način stvaranja statičkog magnetskog polja. Drugi način su 

struje, odnosno gibanje naboja. Struja koja prolazi žicom je okružena magnetskim poljem 𝐵⃗ . Smjer 

magnetskog polja moguće je odrediti pravilom desne ruke: ukoliko se žica obuhvati desnom rukom 

tako da palac pokazuje smjer struje, tada četiri prsta oko žice pokazuju smjer magnetskog polja. 
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Statička magnetska polja djeluju silom na naboje ako se naboji gibaju relativno u odnosu na polje. 

Ta sila se naziva Lorentzova sila i dana je formulom:  

 𝐹 𝐿 = 𝑄(𝑣 × 𝐵⃗ ) (2-3) 

gdje 𝑣  predstavlja brzinu naboja Q[1]. 

U dosadašnjem dijelu rada opisana su statička polja, a osim statičkih postoje i promjenjiva polja. 

Promjenjivo električno polje će inducirati promjenu u magnetskom polju i obratno, što povezuje 

električno i magnetsko polje. James Clerk Maxwell je razvio teoriju koja objašnjava odnos između 

električnog i magnetskog polja pomoću jednadžbi, koje su poznate kao Maxwellove jednadžbe. 

Kasnije je Heinrich Hertz dokazao ono što je Maxwell opisao svojim jednadžbama pomoću 

eksperimenta u kojem je emitirao i primio radio valove. Postoje ukupno četiri Maxwellove 

jednadžbe koje glase[2]:  

1. Ampereov zakon – provedena struja i struja pomaka su uzroci magnetskog polja, odnosno 

vremenski promjenjivo električno polje stvara magnetsko polje. Ukupna struja kroz 

površinu A jednaka je krivuljnom integralu magnetskog polja 𝐻⃗⃗  na površini. U ukupnu 

struju se ubrajaju gustoća provedene struje 𝐽   i gustoća struje pomaka 
𝜕𝐷⃗⃗ 

𝜕𝑡
.  

 
∮ 𝐻⃗⃗  ∙  𝑑𝑠 =  ∬( 𝐽 + 

𝜕𝐷⃗⃗ 

𝜕𝑡
)

 

𝐴

 ∙  𝑑𝐴 

 

𝐶(𝐴)

 (2-4) 

 

2. Faradeyev zakon – vremenski promjenjiv magnetski tok predstavlja izvor električnog 

polja, odnosno vremenski promjenjivo magnetsko polje stvara električno polje. Negativna 

brzina promjene magnetskog toka Ψ𝑚  = ∬ 𝐵⃗  ∙  𝑑𝐴 
 

𝐴
 kroz površinu A jednaka je 

krivuljnom integralu električnog polja 𝐸⃗  na površini. 

 

 
∮ 𝐸⃗  ∙  𝑑𝑠 = −

𝑑

𝑑𝑡
 ∬𝐵⃗  ∙  𝑑𝐴 

 

𝐴

 

𝐶(𝐴)

 (2-5) 

 

3. Gaussov zakon za električno polje – naboji su izvori statičkog električnog polja. Električni 

tok Ψc =  ∬ 𝐷⃗⃗  ∙  𝑑𝐴  koji prolazi kroz zatvorenu površinu jednak je ukupnom naboju Q u 

njezinoj unutrašnjosti. 
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∯𝐷⃗⃗  ∙  𝑑𝐴 

 

𝐴(𝑉)

= ∭ϱ 𝑑𝑣

 

𝑉

= 𝑄 (2-6) 

 

Gaussov zakon za magnetsko polje – magnetski tok kroz bilo koju zatvorenu plohu je jednak 

nuli[1].  

 

 
∯𝐵⃗  ∙  𝑑𝐴 

 

𝐴(𝑉)

= 0 (2-7) 

 

 

2.1. Elektromagnetski valovi 

Elektromagnetski valovi su definirani kao oscilacije električnog i magnetskog polja u prostoru. 

Električno i magnetskog polje su pravokutni jedan u odnosu na drugi, a oba su pravokutna u 

odnosu na smjer širenja vala, kao što je vidljivo na slici 2.1.[3]. 

 

 

Slika 2.1. Širenje elektromagnetskog vala [3] 

Promatrajući odnos magnetskog i električnog polja, prikazan na slici 2.1.,  koji su tumačeni 

Faradayevim i Amperovim zakonom, moguće je vidjeti da porastom električnog polja raste i 

magnetsko polje kao što porastom magnetskog polja raste električno polje. Također, oscilacije 
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električnog polja uzrokuju oscilacije magnetskog polja i obratno. Ovaj fenomen, koji omogućuje  

elektromagnetskom valu putovanje kroz prazan prostor, bez potrebe za medijem naziva se 

propagacija elektromagnetskog vala[2].  

Elektromagnetski valovi se mogu klasificirati prema valnoj duljini, odnosno frekvenciji vala. Ta 

klasifikacija se naziva elektromagnetski spektar, prikazan na slici 2.2.. 

 

Slika 2.2. Elektromagnetski spektar[4] 

Na slici 2.2. se može vidjeti da vidljiva svjetlost zauzima samo mali dio elektromagnetskog 

spektra. Lijevo od vidljivog spektra nalaze se ultraljubičaste (UV) zrake, X-zrake i gama zrake. S 

desne strane vidljivog spektra su zračenja manjih frekvencija. Tu se ubrajaju infracrveno zračenje, 

mikrovalovi  i radiovalovi. Ove vrste zračenja se nalaze posvuda, ali zbog niskih frekvencija nisu 

opasne za zdravlje čovjeka[4]. 

 

2.1.1. Radiovalovi 

Za bežični prijenos informacija pomoću antena koriste se radiovalovi. Radiovalovi su 

elektromagnetski valovi čije su frekvencije u granici od 10 kHz do 3000 GHz. Uzimajući u 

obzir svojstva i pojave radiovalova s obzirom na njihov frekvencijski spektar, postoji podjela 

na devet područja, kao što je prikazano tablicom 2.1.. Simboli pojedinih frekvencijskih 

područja su nastali od kratica njihovih naziva na engleskom jeziku. 

Simbol Naziv Opseg frekvencija Valna duljina 

VLF Vrlo niske frekvencije 3-30 kHz 100-10 km 
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LF Niske frekvencije 30-300 kHz 10-1 km 

MF Srednje frekvencije 300-3000 kHz 1000-100 m 

HF Visoke frekvencije 3-30 MHz 100-10 m 

VHF Vrlo visoke frekvencije 30-300 MHz 10-1 m 

UHF Ultra visoke frekvencije 300-3000 MHz 100-10 cm 

SHF Super visoke frekvencije 3-30 GHz 10-1 cm 

EHF Ekstremno visoke frekvencije 30-300 GHz 10-1 mm 

- - 300-3000 GHz 1-0.1 mm 

Tablica 2.1. Frekvencijska podjela spektra radiovalova 

 

 

Da bi radioprijenos bio moguć potrebni su: 

• Odašiljač, koji služi za stvaranje napona, odnosno struje visoke frekvencije 

• Odašiljačka antena, koja služi za pretvaranje visokofrekvencijske struje u 

elektromagnetske valove te je odgovorna za njihovo širenje prostorom 

• Prijemna antena, koja prima elektromagnetske valove te ih pretvara u 

visokofrekvencijske struje 

• Prijemnik koji prima te struje, te vrši njihovu demodulaciju i pojačava ih.[5] 

Elektromagnetskim valovima koji proizlaze iz odašiljačke antene smanjuje se jakost polja kako se 

udaljenost između antena povećava. Također, u zemaljskim bežičnim komunikacijama dolazi do 

gubitaka u obliku apsorpcije, difrakcije i raspršenja valova zbog prepreka kao što su zgrade, zidovi, 

brda, drveće itd..  

Apsorpcija vala predstavlja gubljenje dijela elektromagnetske energije i pretvaranje iste u 

toplinsku energiju kada ravan val dođe na prepreku napravljenu od određenog materijala. 

Na rubovima predmeta dolazi do difrakcije elektromagnetskih valova, tj. valovi se savijaju oko 

rubova i šire se u područje geometrijske sjene. To se može razumjeti pomoću huygensovog 

principa koji kaže da svaka točka valne fronte stvara elementarni sferni val. Difrakcija 

elektromagnetskih valova je neophodna za bežičnu komunikaciju jer omogućuje radijski prijem 

iza prepreka poput zgrada ili brda. 
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Elektromagnetski val koji je u interakciji s nizom malih objekata (npr. kapi kiše u atmosferi ili 

granama i lišću) proizvodi difuzni odgovor. Na svakom pojedinom objektu postoji refleksija, 

difrakcija, lom i apsorpcija. Superpozicija svih ovih učinaka poznata je kao raspršenje[1].  
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3. ANTENE 

Prijenos elektromagnetske energije se može vršiti na dva načina. Prvi način je vođenje 

elektromagnetskog vala duž jedne materijalne strukture, kao što su linije i valovodi. Drugi način 

podrazumijeva zračenje elektromagnetskog vala slobodnim prostorom koji ne zahtjeva nikakvu 

materijalnu strukturu kao posrednika između odašiljanja i prijema vala. To se odrađuje pomoću 

posebnih geometrijskih struktura, izvedenih od materijala različitih električnih i magnetskih 

svojstava, koje se zovu antene[6]. Antena je naprava koja pretvara električni signal u 

elektromagnetski val i obrnuto[7]. Antena ima dvije funkcije. S jedne strane služi kao element za 

prilagodbu između linije i valovoda, a s druge da usmjerava zračenu energiju na unaprijed utvrđen 

način. Antene se koriste u svim elektroničkim sustavima gdje je medij za prijenos slobodan 

prostor. Vrlo važna stvar kod antena je njezin položaj u odnosu na zemlju i okolne objekte. Postoje 

dvije vrste antena s obzirom na dijagram zračenja: usmjerene i neusmjerene (kružne). Kod 

usmjerenih veza je poželjno da su sekundarne latice što manje i da glavna latica bude vrlo uska, 

kako bi se dobio veći dobitak. Kružne veze se koriste za prijenos radio ili televizijskog programa, 

kako bi prekrile što veći dio geografskog područja[6]. 

 

3.1. Parametri antena 

Glavni parametri antene su: dijagram zračenja, usmjerenost,  dobitak, polarizacija, impedancija,  

efektivna duljina ili visina i temperatura šuma. 

3.1.1. Dijagram zračenja 

Dijagram zračenja antene je definiran kao matematička funkcija ili grafički prikaz svojstava 

zračenja antene kao funkcije prostornih koordinata. U svojstva zračenja se ubrajaju gustoća toka 

snage, intenzitet zračenja, jakost polja, usmjerenost i polarizacija. Za grafički prikaz se koristi 

logaritamska skala u decibelima zato što ona može detaljnije prikazati dijelove koji imaju manje 

vrijednosti odnosno sekundarne latice[8]. Karakteristične veličine dijagrama zračenja, koje se 

nalaze na slici 3.1. su: 

• Smjer maksimalnog zračenja (θ0 i φ0) – predstavlja smjer kod kojeg je amplituda zračenog 

polja maksimalna 
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• Kut usmjerenosti (θD i φD) – predstavlja kut oko glavnog smjera zračenja gdje gustoća 

zračene snage ne pada ispod polovice one snage koja se zrači u smjeru maksimalnog 

zračenja 

• Širina snopa (θn i φn) – predstavlja kut koji je omeđen nultočkama s jedne i druge strane 

maksimalnog zračenja 

• Faktor potiskivanja sekundarnih latica (s) – je odnos između jakosti polja u smjeru 

maksimalnog zračenja i polja u smjeru maksimuma najveće sekundarne latice 

 

Slika 3.1. Dijagram zračenja[9] 

 

3.1.2. Usmjerenost 

Usmjerenost antene je definirana kao omjer intenziteta zračenja u smjeru koji je određen antenom 

i srednje vrijednosti intenziteta zračenja u svim smjerovima. Srednja vrijednost intenziteta zračenja 

jednaka je ukupnoj zračenoj snazi antene podijeljeno sa 4π. Usmjerenost se računa preko formule: 

 
𝐷 =  

𝑈

𝑈0
= 

4πU

𝑃𝑟𝑎𝑑
 (3-1) 

gdje je D usmjerenost, U je intenzitet zračenja, 𝑈0 je srednja vrijednost intenziteta zračenja u svim 

smjerovima, a 𝑃𝑟𝑎𝑑 je ukupna zračena snaga. 

Ukoliko smjer nije specificiran, smjer maksimalnog zračenja je izražen kao:  
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𝐷𝑚𝑎𝑥 = 𝐷0 = 

𝑈𝑚𝑎𝑥

𝑈0
 =  

4πU𝑚𝑎𝑥

𝑃𝑟𝑎𝑑
 (3-2) 

 

pri čemu je  Umax maksimalni intenzitet zračenja. 

Ukoliko se radi o izotropnom izvoru očito je da će usmjerenost biti jedan zato što su vrijednosti 

intenziteta zračenja U i srednja vrijednost intenziteta zračenja U0 iste. 

3.1.3. Dobitak 

Dobitak antene (u danom smjeru) je definiran kao omjer intenziteta zračenja u danom smjeru i 

intenziteta zračenja koje bi imali da je snaga koja je prihvaćena na anteni zračena izotropno. 

Ukoliko smjer nije zadan, dobitak se uzima da je u smjeru maksimalnog zračenja. Formula za 

dobitak je:  

 𝐺 = 𝑒𝑐𝑑 ∙ 𝐷 (3-3) 

 

gdje je ecd korisnost zračenja antene, a D je usmjerenost. Ova formula uzima u obzir gubitke same 

antene, ali ne i gubitke koji nastaju kada je antena spojena na prijenosnu liniju. Ti gubici se obično 

odnose na gubitke prilikom refleksije. Oni se uzimaju u obzir prilikom računanja apsolutnog 

dobitka koji je dan formulom: 

 𝐺𝑎𝑏𝑠 = 𝑒𝑐𝑑 ∙ 𝑒𝑟 ∙ 𝐷 (3-4) 

 

gdje er predstavlja korisnost refleksije. 

 

3.1.4. Polarizacija 

Polarizacija antene u danom smjeru je definirana kao polarizacija vala koji je zračen antenom. 

Polarizacija zračenog vala je svojstvo elektromagnetskog vala koje opisuje vremenski promjenjivi 

smjer i relativnu veličinu vektora električnog polja[8]. Definirana je krivuljom koja opisuje vrh 

vektora električnog polja u ravnini okomitoj na smjer širenja vala u smjeru maksimalnog 

zračenja[9]. Postoje tri vrste polarizacije:  
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• Linearna polarizacija – vremenski harmonični val je linearno polariziran u određenoj točki 

u prostoru ako je vektor električnog (ili magnetskog) polja u toj točki orijentiran duž iste 

ravne linije u bilo kojem trenutku. 

• Kružna polarizacija – vremenski harmonični val je kružno polariziran u određenoj točki u 

prostoru ako vektor električnog (ili magnetskog) polja u toj točki uvijek prati kružnicu kao 

funkcija vremena. 

• Eliptična polarizacija – vremenski harmonični val je eliptično polariziran ako vrh vektora 

električnog (ili magnetskog) polja prati elipsu u prostoru. U različitim vremenskim 

trenucima vektor polja se kontinuirano mijenja. Postoji lijeva i desna eliptična polarizacija, 

ovisno o smjeru rotacije vektora polja[8]. 

3.1.5. Impedancija 

Impedancija antene je jednaka omjeru napona i struje na priključcima antene. Ukoliko je antena u 

slobodnom prostoru gdje su svi objekti na dovoljno velikoj udaljenosti od antene, tada se radi o 

vlastitoj impedanciji antene. Gubitak snage koji nastaje prilikom zračenja odašiljačke antene u 

prostoru se može predstaviti zamišljenim otporom koji je dio omske komponente vlastite 

impedancije, a naziva se otpor zračenja i označen ja sa Rz. Otpor zračenja je ekvivalentan otporu 

na kojem se troši snaga jednaka ukupnoj zračenoj snazi antene, ako je struja kroz taj otpor jednaka 

struji kroz stezaljke antene.  

 
𝑅𝑧 = 

𝑃𝑡

𝐼2
 (3-5) 

 

Materijal od kojeg je napravljena antena ima otpor, te će se zbog tog dio elektromagnetske energije 

pretvoriti u toplinu. Taj otpor se naziva otpor gubitaka i označen je sa Rd. Treća komponenta 

vlastite impedancije je reaktivna komponenta Xa koja ovisi o indukcijskom polju koje stvara 

uskladištenu energiju u neposrednoj blizini antene. Stoga je vlastita impedancije antene dana 

formulom:  

 𝑍𝐴 = 𝑅𝑧 + 𝑅𝑑 + 𝑗𝑋𝐴 (3-6) 
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3.1.6. Efektivna duljina ili visina 

Kod prijemne antene efektivna duljina lef odnosno efektivna visina hef je definirana kao omjer 

napona na stezaljkama otvorene antene i jakosti električnog polja na mjestu prijema, ako je antena 

orijentirana u smjeru polja: 

 
𝑙𝑒𝑓 = ℎ𝑒𝑓 =

𝑈𝑝

𝐸
 (3-7) 

 

Kod odašiljačke antene, efektivna duljina lef odnosno efektivna visina hef je jednaka duljini 

ekvivalentne linearne antene koja ima konstantnu struju po cijeloj svojoj duljini, s tim što obje 

antene imaju jednak intenzitet zračenja u smjeru okomitom na duljinu i jednaku struju na 

stezaljkama antene: 

 

𝑙𝑒𝑓 =
1

𝐼(0)
∫ 𝐼(𝑧)𝑑𝑧

𝐿
2

−
𝐿
2

 (3-8) 

 

 

ℎ𝑒𝑓 =
1

𝐼(0)
∫ 𝐼(𝑧)𝑑𝑧

𝐻

0

 (3-9) 

 

3.1.7. Temperatura šuma 

Temperatura šuma je definirana za prijemnu antenu. To je mjera za snagu šuma koju antena 

predaje na ulazu u prijemnik. Vanjski izvori šuma i njihovi položaji u odnosu na dijagram zračenja 

imaju najveći utjecaj na snagu šuma. Temperatura šuma je dana formulom: 

 
𝑇𝐴 =

𝑃š

𝑘 ∙ 𝐵
 (3-10) 

 

gdje je Pš raspoloživa snaga šuma na ulazu u prijemnik, k je Boltzmanova konstanta, a B je širina 

frekvencijskog pojasa[9]. 
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3.2. Konusni dipol 

Dipoli u obliku štapa su povoljni za modeliranje zbog relativno jednostavnih jednadžbi koje 

opisuju distribuciju struje na njima, ali nisu baš praktični za testiranje rada antene u 

elektromagnetskom okruženju. Razlog tomu je što takvom dipolu treba mehanički promijeniti 

duljinu za svaku različitu frekvenciju na kojoj se antena ispituje. Širokopojasna antena koju nije 

potrebno podešavati je puno primjerenija za testiranja. Dvije širokopojasne antene koje se najčešće 

koriste za testiranja su konusni dipol za frekvencije od 30 MHz do 300 MHz, te linearno 

logaritamska antena za frekvencije od 300 MHz do 1GHz[10]. 

Konusni dipol je širokopojasna antena koja se sastoji od dva vodiča u obliku konusa. U teoriji, 

beskonačni konusni dipol je frekvencijski neovisna antena, ali konačnom konusnom dipolu 

frekvencija utječe na ulaznu impedanciju  i dijagram zračenja. Impedancija konusnog dipola ovisi 

o  geometriji konusa. U važne parametre se ubrajaju kut α, duljina l i polumjer konusa r, te razmak  

između konusa g, prikazani slikom 3.2.[11]. 

 

Slika 3.2. Geometrija konusnog dipola[11] 

  

Antene u obliku konusa su skupe za proizvodnju pa se stoga u praksi koristi žičana struktura u 

obliku kaveza. Utvrđeno je da se zadovoljavajuća električna aproksimacija konusu može postići 

pomoću šest žica koje su savijene i spojene na krajevima te sedme žice koja prolazi kroz sredinu 

kao što je prikazano na slici 3.3.[10]. 
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Slika 3.3. Konusni dipol[12] 
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4. S PARAMETRI 

Pri  mjerenju struja i napona na mikrovalnim frekvencijama javlja se problem jer je pri izravnom 

mjerenju potrebno uzeti u obzir magnitudu i fazu vala, pa se stoga struje i naponi ne računaju kod 

mreža sa visokim frekvencijama. Prikaz koji je više u skladu s izravnim mjerenjima,  koji uzima 

u obzir upadne, reflektirane i odaslane valove odrađuje se pomoću S parametara. U nekim 

slučajevima S parametre je moguće izračunati, a u većini slučajeva moguće ih je izravno izmjeriti 

pomoću vektorskog analizatora mreže[13]. S parametri u mreži sa N priključaka opisuju upadni 

signal na bilo kojem od priključaka. Najčešće su prikazuju pomoću matrica, pri čemu će dimenzije 

matrice biti jednake broju priključaka. Za parametar Sij, indeks j označava ulazni (pobuđeni) 

priključak, a indeks i označava izlazni priključak. U ovom će se radu koristiti dvije antene, što 

znači da će se raditi s mrežom koja ima dva priključka. Matrica će biti oblika:  

 
[
𝑏1

𝑏2
] = [

𝑆11 𝑆12

𝑆21 𝑆22
] × [

𝑎1

𝑎2
] (4-1) 

Pri čemu varijabla ai predstavlja upadni val na priključku i, a bj predstavlja reflektirani val s 

priključka j. U mreži s dva priključka, odnosno antene, postoje četiri S parametra:  

1.) S11 –  predstavlja koeficijent refleksije na prvoj anteni, jednak je omjeru reflektiranog vala 

na prvoj anteni i upadnog vala na istoj anteni 

2.) S12 – predstavlja koeficijent transmisije s druge antene na prvu, jednak je omjeru 

reflektiranog vala na prvoj anteni, i upadnog vala sa druge antene 

3.) S21 – predstavlja koeficijent transmisije s prve antene na drugu, jednak je omjeru 

reflektiranog vala na drugoj anteni, i upadnog vala sa prve antene 

4.) S22 – predstavlja koeficijent refleksije na drugoj anteni, jednak je omjeru reflektiranog vala 

na drugoj anteni i upadnog vala na istoj anteni[14] 

 

 

 

 

 

 



 

17 

5. ANSYS HFSS 

5.1. Opis programa 

Simulacija apsorpcije energije elektromagnetskog zračenja pri prolasku vala kroz armirani beton 

se izvodi u programu Ansys 2022 R1. Ansys HFSS je softver za 3D elektromagnetsko 

projektiranje i simulaciju visokofrekvencijskih elektroničkih proizvoda kao što su antene, antenski 

nizovi i sl. Koristi se za dizajniranje komponenata koje se koriste u komunikacijskim sustavima, 

radarskim sustavima, satelitima, internetu stvari (eng. Internet of things) i drugim uređajima koji 

rade na radijskim frekvencijama. Integracijom s Ansys alatima za toplinsku, strukturnu mehaniku 

i mehaniku fluida, HFSS pruža potpunu i snažnu analizu elektroničkih proizvoda osiguravajući 

toplinsku i strukturnu pouzdanost[15]. 

 

Slika 5.1. Prikaz programa Ansys HFSS 

Program Ansys HFSS se sastoji od nekoliko važnih dijelova koji su vidljivi na slici 5.1. : 

• Alatna traka – sadrži prečace za često korištene naredbe koji je moguće prilagoditi prema 

načinu koji odgovara korisnicima 

 

Slika 5.2. Alatna traka 
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• Upravitelj projekta (eng. Project manager) – sadrži stablo dizajna koje prikazuje strukturu 

cjelovitog projekta 

 

Slika 5.3. Upravitelj projekta 

• Svojstva (eng. Properties) – omogućuje promjenu svojstava modela ili njegovih dijelova 

kao što su ime, materijal od kojeg je model napravljen, njegovu orijentaciju, boju i 

transparentnost 

 

Slika 5.4. Svojstva  

• Stablo dizajna – sadrži sve kreirane geometrijske likove i informacije o njima 
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Slika 5.5. Stablo dizajna 

• Prikaz poruka (eng. Message manager) – prikazuje poruke i upozorenja koja se mogu 

dogoditi prije simulacije 

 

Slika 5.6. Prikaz poruka 

• Prikaz napretka (eng. Progress manager) – prikazuje napredak rješenja 

 

Slika 5.7. Prikaz napretka 

• Prostor za 3D modeliranje (eng. 3D modeler window) – sadrži grafički prikaz modela 
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Slika 5.8. Prostor za 3D modeliranje 

5.2. Kreiranje konusnog dipola 

Zadatak ovog rada je simulirati utjecaj prepreke na elektromagnetski val. Simulacija se izvodi u 

frekvencijskom opsegu od 1 do 2 GHz. Ovaj frekvencijski opseg spada u područje ultra visokih 

frekvencija (UHF) koje se među ostalima koristi za satelitsku komunikaciju, GPS, Wi-Fi, 

bluetooth, televizijski prijenos, mobilnu komunikaciju i druge[16]. Budući da je beton često 

korišten građevinski materijal, te uzimajući u obzir široku primjenu navedenih bežičnih 

komunikacija, važno je ispitati utjecaj betona na ovom frekvencijskom opsegu. Najprije je 

potrebno kreirati antenu kako bi se simulirali njezini parametri u slobodnom prostoru. Za antenu 

je odabran konusni dipol zato što ga njegov širok pojas frekvencija, kružni dijagram zračenja te 

jednostavno korištenje čine dobrim izborom za ispitivanje zračenja elektromagnetskog vala. 

Konusni dipol se sastoji od dva konusa odvojena praznim prostorom na koji se dovodi napajanje. 

Nakon što je napravljen konusni dipol potrebno je simulirati koeficijent refleksije S11, VSWR, 

ulaznu impedanciju i dijagram zračenja kako bi se ispitao rad antene u slobodnom prostoru. Dodaje 

se još jedan konusni dipol i simuliraju se koeficijenti transmisije, koji će se kasnije usporediti sa 

koeficijentima transmisije u slučaju s preprekama od betona i armiranog betona, kako bi se odredio 

utjecaj prepreke. Kreira se betonska prepreka sa prostornim dimenzijama 600 x 600 mm, debljine 

200 mm i ponovno se simuliraju koeficijenti transmisije. Na kraju je još potrebno u beton staviti 
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željezne šipke različitih dimenzija i debljine, kako bi se ispitali koeficijenti transmisije kroz 

armirani beton. 

Simulacija će se odraditi u programu Ansys 2022 R1. Za početak je potrebno pokrenuti program 

Ansys te stvoriti novi projekt tako što se na alatnoj traci odabere opcija File → New (slika 5.9.). 

Nakon toga treba odabrati dizajn. Za potrebe ovog rada koristi se HFSS dizajn koji se odabire 

pomoću alatne trake klikom na Project → Insert HFSS design (slika 5.10.). 

 

Slika 5.9. Kreiranje novog projekta 

 

Slika 5.10. Odabir dizajna 

Najprije je potrebno kreirati konusni dipol. Duljina svakog konusa će iznositi 72.5 mm, pri čemu 

će promjer manje kružnice konusa iznositi 30 mm, a promjer veće kružnice 200 mm. Razmak 

između konusa iznosi 15 mm, a za materijal od kojeg je izrađen konusni dipol odabran je aluminij. 
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Kreiranje konusnog dipola u programu se može uraditi na način da se nacrtaju dvije kružnice i 

jedan valjak pomoću naredbi Draw circle i Draw cylinder na alatnoj traci. Valjak predstavlja 

razmak između dva konusa, a kružnice će se kasnije spojiti s valjkom kako bi se dobili konusi. 

 

Slika 5.11. Naredba Draw circle 

 

Slika 5.12. Naredba Draw cylinder 

Nakon crtanja potrebno je promijeniti njihove parametre dvostrukim klikom na Createcylinder 

koji se nalazi u stablu dizajna. Time se otvara novi prozor u kojem treba promijeniti vrijednosti 

polumjera i visine valjka na 15 mm unošenjem te vrijednosti u stupce Radius i Height. Također je 

važno promijeniti koordinate koje se nalaze u stupcu Center Position kako bi bile u skladu sa 

ostalim dijelovima antene, a kasnije u skladu s preprekom i drugom antenom. Prozor s unesenim 

vrijednostima nalazi se na slici 5.13.  
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Slika 5.13. Parametri u Createcylinder 

Isto je potrebno uraditi i za kružnice. Dvostrukim klikom na Createcircle otvara se novi prozor sa 

svojstvima. U stupac Radius za obje kružnice se unosi polumjer od 100 mm, a koordinate koje se 

unose u stupac Center Position se razlikuju kako bi jedna kružnica bila ispod, a druga iznad valjka. 

Uneseni parametri za gornju kružnicu prikazani su slikom 5.14. a uneseni parametri donje kružnice 

slikom 5.15.  

 

 

Slika 5.14. Parametri u Createcircle za Circle1 
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Slika 5.15. Parametri u Createcircle za Circle2 

Kako bi  kružnica i valjak bili povezani da bi se dobio konus najprije je potrebno stisnuti slovo F 

na tipkovnici čime se uključuje opcija Select Faces i odabrati gornju kružnicu valjka te izabrati 

naredbu Modeler  → Surface → Create object from face (slika 5.16.).  

 

Slika 5.16. Naredba za stvaranje objekta iz face 

Nakon toga stisnuti O na tipkovnici koja uključuje opciju Select Objects i odabrati naredbu Edit 

→ Select → By name (slika 5.17.) čime se otvara novi prozor. U tom prozoru treba istovremeno 

odabrati Circle1 i Cylinder1_ObjectFromFace1 te stisnuti OK (slika 5.18.). Za odabir obje 

odjednom potrebno je držati tipku ctrl na tipkovnici.  
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Slika 5.17. Naredba za odabiranje objekata prema imenu 

 

Slika 5.18. Biranje objekata 

Na kraju izabrati naredbu Modeler → Surface → Connect (slika 5.19.) kojem se spaja kružnica s 

valjkom i dobije se konus. Isti postupak je potrebno ponoviti i sa donjom kružnicom valjka i 

kružnicom Circle2.  
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Slika 5.19. Naredba za spajanje odabranih objekata 

Potrebno je promijeniti materijal od kojeg su napravljeni konusi u aluminij. To se odrađuje klikom 

na željeni dio antene čime se sa lijeve strane u programu otvaraju svojstva gdje je moguće 

promijeniti materijal klikom na Material → edit... (slika 5.20.). Time se otvara prozor u kojem je 

potrebno pronaći i odabrati aluminum te stisnuti OK (slika 5.21.). 

 

Slika 5.20. Svojstva materijala 
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Slika 5.21. Odabir materijala 

Kako bi se dodijelila pobuda konusnom dipolu potrebno je dodati jedan pravokutnik u YZ ravnini 

na mjestu koje predstavlja prazan prostor između dipola pomoću naredbe Draw rectangle (slika 

5.22.). Dvostrukim klikom na Createrectangle novonastalog pravokutnika otvara se prozor sa 

svojstvima. U prozoru se postavljaju vrijednosti u stupcima YSize i ZSize  na 30 i 15 mm, a 

potrebno je promijeniti i koordinate u stupcu Position kako je prikazano na slici 5.23. 

 

Slika 5.22. Naredba Draw rectangle 
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Slika 5.23. Parametri u Createrectangle 

Napajanje se dodaje desnim klikom na pravokutnik i odabirom naredbe Assign excitation → 

Lumped port (slika 5.24.) čime će se otvoriti postavke na koje je prvo potrebno stisnuti Next a 

zatim dodati novu liniju u smjeru od dolje prema gore (slika 5.25.) i zatim stisnuti Next, pa Finish. 
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Slika 5.24. Dodjeljivanje pobude 

 

Slika 5.25. Dodavanje nove linije 

Sljedeći korak je dodavanje prostora za zračenje. Visina i širina prostora za zračenje je uzeta kako 

bi se prilagodila prepreci koja će kasnije biti dodana, a duljina je uzeta proizvoljno, uzimajući u 

obzir da ostane dovoljan prostor da se smjeste dvije antene na 0.8 metara udaljenosti sa obje strane 

prepreke. Visina i širina prostora za zračenje iznose 600 mm, a duljina 2400 mm.  Prostor za 

zračenje se može dodati pomoću naredbe Draw box na alatnoj traci (slika 5.26.), kojoj je potrebno 

promijeniti parametre u CreateBox koji se nalazi u stablu dizajna kako je prikazano slikom 5.27.  

 

Slika 5.26. Naredba Draw box 
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Slika 5.27. Parametri u CreateBox za Box1 

Također je potrebno promijeniti materijal u zrak postupkom koji je ranije objašnjen (str. 26 i 27) 

a korisno je i promijeniti transparentnost kutije kako bi konusni dipol unutar nje bio vidljiv. 

Transparentnost se mijenja klikom na kutiju i odabirom parametra Transparent u svojstvima (slika 

5.28.). Desnim klikom na kutiju moguće je dodijeliti granicu prostora za zračenje klikom na Assign 

boundary → Radation... (slika 5.29.) nakon čega se otvara novi prozor na koji je potrebno stisnuti 

OK. 

 

 

Slika 5.28. Svojstva kutije Box1 
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Slika 5.29. Dodjeljivanje granice zračenja 

Ovime je napravljen konusni dipol i prostor u kojem on zrači. Sada treba odraditi analizu 

parametara S11, dijagrama zračenja, VSWR, i ulazne impedancije. Najprije je potrebno postaviti 

rješenje simulacije pomoću desnog klika na Analysis u upravitelju projekta i odabrati opciju Add 

solution setup čime se otvara novi prozor na koji je potrebno stisnuti OK (slika 5.30.).  
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Slika 5.30. Dodavanje rješenja simulacije 

Sljedeći korak je dodavanje raspona frekvencije. U radu se ispituje rad antene u frekvencijskom 

području od 1 GHz do 2 GHz, ali će se konusni dipol u slobodnom prostoru simulirati u rasponu 

frekvencija 0.5-5 GHz kako bi se prikazao cijeli frekvencijski opseg na kojem antena može raditi. 

Raspon frekvencije se dodaje desnim klikom na novonastalo rješenje simulacije Setup1 i odabirom 

Add Frequency Sweep čime se otvara novi prozor kojemu je potrebno dodijeliti parametre 

prikazane na slici 5.31. i stisnuti OK. Preostalo je još analizirati simulaciju što se može uraditi 

naredbom Analyze All (slika 5.32.) koja se nalazi na alatnoj traci.  

 

Slika 5.31. Postavljanje raspona frekvencije 

 

Slika 5.32. Naredba Analyze All 
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5.1. Rezultati simulacije zračenja konusnog dipola u slobodnom prostoru 

Rezultat S11, odnosno koeficijent refleksije moguće je prikazati desnim klikom na Results koji se 

nalazi u upravitelju projekta i odabirom opcije Create Modal Solution Data Report → Rectangular 

Plot (slika 5.33.). Time se otvara prozor u kojem je potrebno pronaći i odabrati parametar S11 te 

stisnuti New Report (slika 5.34.).  

 

Slika 5.33. Naredba za stvaranje rješenja simulacije 



 

34 

 

Slika 5.34. Odabir parametara za prikaz 

 

Slika 5.35. Koeficijent refleksije S11 konusnog dipola u frekvencijskom opsegu 0.5-5 GHz 

Na slici 5.35. prikazan je koeficijent refleksije S11 za zračenje konusnog dipola u slobodnom 

prostoru u frekvencijskom opsegu od 500 MHz do 5 GHz. Koeficijent refleksije S11 predstavlja 

snagu upadnog vala koja je reflektirana od antene[17]. Na slici se može vidjeti da antena najbolje 

radi na frekvenciji od 2.63 GHz jer su tada gubici -36.24 dB što znači da je tu reflektirana snaga 
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najmanja, dok će u frekvencijskom opsegu 1-2 GHz najbolje raditi na frekvenciji od 1.63 GHz 

kada koeficijent refleksije iznosi -30.48 dB. U frekvencijskom opsegu 1-2 GHz antena će najlošije 

funkcionirati na frekvenciji od 1 GHz kada će reflektirani gubici iznositi -10.46 dB. Točne 

vrijednosti frekvencija i reflektirane snage na minimumu i maksimumu u frekvencijskom opsegu 

1-2 GHz mogu se odrediti desnim klikom i odabirom opcije Trace Characteristics → Add… 

Ovime je otvoren novi prozor u kojem se na mjestu Function odabire min, a u stupcu Value treba 

odabrati Specified. Za početnu frekvenciju u red Start of Range upisati 1 GHz, a za krajnju u red 

End of Range upisati 2 GHz (slika 5.36.). 

 

Slika 5.36. Odabir minimalne vrijednosti koeficijenta refleksije u frekvencijskom opsegu 1-2 GHz 

Za prikaz dijagrama odnosa stojnih valova VSWR potrebno je desnim klikom na Results odabrati 

opciju Create Modal Solution Data Report → Rectangular Plot (slika 5.33.). Time se otvara 

prozor u kojem se na mjestu category odabire VSWR, a na mjestu Function odabire se <none>, 

kao što je prikazano na slici 5.37. 
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Slika 5.37. Odabir parametara za prikaz VSWR 

Odnos stojnog vala, odnosno VSWR je funkcija koeficijenta refleksije, koji opisuje snagu koja je 

reflektirana od antene. Za antene je poželjno da je odnos stojnog vala što manji, što znači da je 

više snage upadnog vala predano anteni. Najmanji iznos za VSWR je 1, i u tom slučaju nema 

refleksije snage od antene[18]. 

 

Slika 5.38. Odnos stojnog vala (VSWR) konusnog dipola u frekvencijskom opsegu 0.5-5 GHz 
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Promatrajući dijagram odnosa stojnih valova prikazan na slici 5.38. može se zaključiti da antena 

u frekvencijskom opsegu 1-2 GHz najbolje funkcionira na frekvenciji od 1.63 GHz zato što je na 

toj frekvenciji omjer stojnog vala najmanji te iznosi 1.06.  

Za prikaz ulazne impedancije potrebno je desnim klikom na Results odabrati opciju Create Modal 

Solution Data Report → Rectangular Plot. U novootvorenom prozoru potrebno je odabrati Z 

parametar a za funkciju odabrati re i stisnuti New Report, te nakon toga za funkciju odabrati im i 

stisnuti Add Trace.  

 

Slika 5.39. Ulazna impedancija konusnog dipola u frekvencijskom opsegu 0.5-5 GHz 

Rezultati ulazne impedancije za simulaciju zračenja antene u slobodnom prostoru su prikazani na 

slici 5.39.. Na frekvenciji od 1.63 GHz impedancije antene iznosi 52.75 - j1.38 Ω, što je približno 

impedanciji od 50 + j0 Ω na koju se antena prilagođava.  

Kako bi se dobio dijagram zračenja potrebno je desnim klikom na Radiation u upravitelju projekta 

odabrati opciju Insert Far Field Setup → Infinite Sphere... nakon čega se otvara novi prozor u koji 

je potrebno unijeti parametre prikazane na slici 5.40. i stisnuti OK.  
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Slika 5.40. Parametri za dodavanje zračenja 

Dijagram zračenja se prikazuje desnim klikom na Results u upravitelju projekta i odabirom opcije 

Create Far Fields Report → Radiation Pattern čime se otvara novi prozor na kojem je potrebno 

u mjestu Category odabrati rE, za Quantity rETotal, a za Function dB (slika 5.41.). Nakon toga 

kliknuti na Families gdje je potrebno kod varijable Phi stisnuti na tri točke i odabrati 0 deg (slika 

5.42.).  
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Slika 5.41. Odabir parametara za prikaz dijagrama zračenja 

 

 

Slika 5.42. Odabir kutova za varijablu Phi 
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Slika 5.43. Dijagram zračenja konusnog dipola sa poljem u E ravnini 

Za prikaz dijagrama zračenja u 3D potrebno je desnim klikom na Results odabrati opciju Create 

Far Fields Report → 3D Polar Plot (slika 5.44.) nakon čega se otvara novi prozor u kojem na 

mjestu Category treba odabrati rE, na Quantity odabrati rETotal, a za Function se odabire dB  

(slika 5.45.). 

 

Slika 5.44. Naredba za stvaranje rješenja simulacije za 3D dijagram zračenja 



 

41 

 

Slika 5.45. Odabir parametara za 3D dijagram zračenja 

 

 

Slika 5.46. 3D Dijagram zračenja konusnog dipola 

5.2. Kreiranje drugog konusnog dipola 

Nakon što je odrađena simulacija potrebno je napraviti još jedan konusni dipol. Antenu je moguće 

kopirati tako što se označi antena držanjem lijevog klika miša i povlačenjem preko antene nakon 

čega se desnim klikom odabire opcija Edit → Duplicate → Along Line. Prilikom kopiranja antene 
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treba držati tipku Y kako bi se antena premještala samo po Y osi. Potrebno je namjestiti udaljenost 

po Y osi na 2000 mm kako bi kasnije, kada se prepreka napravi, udaljenost između antene i 

prepreke bila 0.8 metara. Kopiranoj anteni je potrebno dodati pobudu čiji je proces prethodno 

opisan kada je pravljena prva antena. Prije simulacije potrebno je još promijeniti frekvencijski 

opseg za koji će se vršiti simulacija dvostrukim klikom na Sweep koji se nalazi u upravitelju 

projekta pod Analysis → Setup1 → Sweep. Za početnu frekvenciju u stupac Start unijeti 1 GHz, a 

za krajnju u stupac End unijeti 2 GHz. Step Size postaviti na 10 MHz.  

 

Slika 5.47. Model simulacije za dva konusna dipola u slobodnom prostoru 

 

5.3. Rezultati simulacije zračenja dva konusna dipola u slobodnom prostoru 

Simulaciju je potrebno analizirati naredbom Analyze all. S parametre simulacije zračenja u 

slobodnom prostoru moguće je prikazati desnim klikom na Results i odabirom opcije Create 

Modal Solution Data Report → Rectangular Plot čime se otvara novi prozor u kojem se odabiru 

parametri tako da na mjestu Category bude S Parameter, na mjestu Quantity je S(1,2), a na 

Function je dB te stisnuti New Report. Nakon toga ponoviti isti proces još dva puta tako da na 

mjestima Category i Function ostaju isti parametri, a na mjestu Quantity odabrati S(2,1), te nakon 

tog S(2,2)  (slika 5.48.). 
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Slika 5.48. Odabir parametara za prikaz koeficijenata transmisij 

 

Slika 5.49. Koeficijent transmisije S12 između konusnih dipola u slobodnom prostoru u 

frekvencijskom opsegu 1-2 GHz 

Parametar S12 predstavlja snagu koju je primila prva antena od ukupne snage koju je predala druga 

antena. Primjerice, ukoliko je S12 = 0 dB, to znači da je sva zračena snaga druge antene predana 

prvoj anteni[17]. Na slici 5.49. je prikazan koeficijent transmisije S12 između dva konusna dipola 
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koja se nalaze u slobodnom prostoru. Vidljivo je da će konusni dipoli najbolje funkcionirati na 

frekvenciji od 1.82 GHz kada će koeficijent transmisije S12 iznositi -26.5 dB. Na frekvenciji od 

1.63 GHz, koja predstavlja radnu frekvenciju konusnog dipola, koeficijent transmisije iznosi -

27.43 dB. 

 

Slika 5.50. Koeficijent transmisije S21 između konusnih dipola u slobodnom prostoru u 

frekvencijskom opsegu 1-2 GHz 

Parametar S21 predstavlja snagu koju je primila druga antena od ukupne zračene snage koju je 

predala prva antena. Ako se usporede parametri S12 i S21 moguće je vidjeti da su oni u potpunosti 

isti zato što se koriste iste antene. 

 

Slika 5.51. Koeficijent refleksije S22 drugog konusnog dipola u slobodnom prostoru u 

frekvencijskom opsegu 1-2 GHz 
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Na slici 5.51. moguće je vidjeti da će drugi konusni dipol najbolje funkcionirati na frekvenciji od 

1.63 GHz kada koeficijent refleksije iznosi -30.21 dB. 

5.4. Kreiranje betonske prepreke 

Kako bi se ispitao utjecaj prepreke na rad antene koristit će se betonski blok postavljen između 

dva konusna dipola te će se simulirati njegov utjecaj na koeficijente transmisije antena. Koristi se 

beton zato što on ima dobru apsorpciju energije elektromagnetskih valova, a na nju najviše utječe 

debljina samog betona. Betonski blok će imati visinu i dužinu iznosa 600 mm, i debljinu od 200 

mm sa gustoćom od 2600 
𝑘𝑔

𝑚3. Relativna permitivnost betona ovisi najviše o količini vlage i smjesi 

od koje je napravljen, sa vrijednošću od 2.5 do 7 
𝐹

𝑚
 za suhi beton. Za ovu simulaciju koristit će se 

relativna permitivnost u iznosu od 6 
𝐹

𝑚
 . Budući da beton nije magnetski materijal, njegova 

relativna permeabilnost µr iznosi 1 
𝐻

𝑚
. Beton nije vodljivi materijal, a njegova vodljivost 𝜎 iznosi 

približno 0.0001 
𝑆

𝑚
. Tangens dielektričnog gubitka 𝑡𝑎𝑛 𝛿 materijala označava rasipanje električne 

energije. Povećava se sa frekvencijom, a na frekvencijama od 1 do 2 GHz za suhi beton iznos joj 

je približno jednak 0[19]. 

U programu betonski blok je moguće napraviti pomoću naredbe Draw box koja se nalazi na alatnoj 

traci. Nakon što je napravljena kutija potrebno joj je promijeniti parametre tako da se u stupac 

XSize unese vrijednost od 600 mm, u stupac YSize vrijednost od 200 mm, a u stupac ZSize 

vrijednost od 600 mm. Kako bi se prepreka nalazila na sredini sa udaljenošću 0.8 metara od obje 

antene potrebno joj je promijeniti koordinate tako da joj se u stupac Position unesu vrijednosti 

prikazane slikom 5.52.  
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Slika 5.52. Parametri u CreateBox za Box2 

Napravljenoj kutiji treba promijeniti materijal od kojeg je napravljena. Budući da betona nema u 

biblioteci materijala potrebno ga je napraviti pomoću desnog klika miša na stvorenu kutiju i 

odabrati opciju Assign Material... čime se otvara novi prozor na kojem je potrebno kliknuti Add 

Material (slika 5.53.) te mu dodijeliti vrijednosti prikazane slikom 5.54. i pritisnuti OK. 

 

 

Slika 5.53. Dodavanje novog materijala 
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Slika 5.54. Postavljanje svojstava materijala 

 

Slika 5.55. Model simulacije za dva konusna dipola s betonskom preprekom 
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5.5. Rezultati simulacije zračenja dva konusna dipola s betonskom 

preprekom 

Potrebno je analizirati simulaciju naredbom Analyze all. Rezultate S11, S12 i S21 simulacije zračenja 

kroz betonsku prepreku moguće je prikazati desnim klikom na Results i odabirom opcije Create 

Modal Solution Data Report → Rectangular Plot čime se čime se otvara novi prozor u kojem treba 

odabrati parametre tako da na mjestu Category bude odabrano S Parameter, na mjestu Quantity je 

S(1,1), a na Function je dB. Nakon što su dodijeljeni parametri stisnuti New Report. Za prikaz 

koeficijenata transmisije S21 i S12 potrebno je ponoviti isti proces još jednom, ali sada na mjestu 

Quantity odabrati S(2,1), odnosno S(1,2) (slika 5.56.). 

 

Slika 5.56. Odabir parametara za prikaz koeficijenata transmisije  
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Slika 5.57. Koeficijent refleksije S11 konusnog dipola s betonskom preprekom u frekvencijskom 

opsegu 1-2 GHz 

Slika 5.57. pokazuje da će konusni dipol najbolje zračiti na frekvenciji od 1.67 GHz kada je 

koeficijent refleksije najmanji i iznosi -33.31 dB. 

 

Slika 5.58. Koeficijent transmisije S21 kroz prepreku od betona (crvena krivulja) i koeficijent 

transmisije u slobodnom prostoru (plava krivulja) u frekvencijskom opsegu 1-2 GHz 

Na slici 5.58. se nalazi koeficijent transmisije S21 za dvije antene između kojih se nalazi betonska 

prepreka. Radi usporedbe, dodan je koeficijent transmisije S21 u slobodnom prostoru koji je 

predstavljen plavom krivuljom. Na slici je moguće vidjeti da je koeficijent transmisije S21 u 

slobodnom prostoru veći na velikom dijelu frekvencijskog spektra od 1 do 2 GHz, što znači da 
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beton apsorbira određeni dio energije. Podatak avg na desnoj strani slike 5.57. prikazuje srednju 

vrijednost koeficijenata transmisije na grafu. Vidljivo je da za konusne dipole s betonskom 

preprekom ona iznosi -29.71 dB, dok za konusne dipole u slobodnom prostoru iznosi -28.9 dB, što 

i dokazuje da će beton u prosjeku apsorbirati veći dio energije. Također se može vidjeti da 

koeficijent transmisije S21 kroz betonsku prepreku ima veći maksimum od koeficijenta transmisije 

u slobodnom prostoru, te da se dodavanjem betonske prepreke mijenja frekvencija na kojoj se 

nalazi najveća vrijednost koeficijenta transmisije. Konusni dipol u slučaju s betonskom preprekom 

najbolje radi na frekvenciji od 1.91 GHz kada koeficijent transmisije iznosi -26.41 dB. Na 

frekvenciji od 1.67 GHz, na kojoj se nalazi minimum koeficijenta refleksije S11, koeficijent 

transmisije S21 iznosi -28.28 dB. 

 

Slika 5.59. Koeficijent transmisije S12 kroz prepreku od betona u frekvencijskom opsegu 1-2 GHz 

Na slici 5.59. se nalazi koeficijent transmisije S12 između dva konusna dipola sa betonskom 

preprekom. Moguće je uočiti da su i ovdje, kao i kod slučaja bez prepreke, koeficijenti transmisije 

S12 i S21 jednaki. Koeficijenti transmisije S12 i S21 u ovoj simulaciji će uvijek biti jednaki zato što 

se koriste identične antene koje se nalaze na jednakoj udaljenosti od prepreke, pa će stoga u ostatku 

rada biti prikazivani samo koeficijenti transmisije S21. 

5.6. Kreiranje prepreke od armiranog betona 

Za stvaranje armiranog betona potrebno je napraviti željeznu rešetku. U radu će se simulirati 

zračenje vala kroz šest različitih rešetki unutar betona. Najprije će se simulirati beton s rešetkom 

kod koje međusobna udaljenost između šipki iznosi 70 mm, pri čemu će debljina, odnosno promjer 

svake šipke iznositi 8 mm za prvi slučaj, te 10 mm za drugi. Nakon nje simulira se beton s rešetkom 
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kod koje su međusobne udaljenosti između šipki 100 mm, sa debljinom šipke koja u prvom slučaju 

iznosi 8 mm, a u drugom 10 mm. Na kraju se još simulira beton s rešetkom kod koje su šipke 

međusobno udaljene 140 mm, sa debljinama šipki od 8 mm i 10 mm.   

Za kreiranje željezne rešetke u programu najprije je potrebno napraviti jednu šipku pomoću 

naredbe Draw Cylinder koja se nalazi na alatnoj traci. Dvostrukim klikom na novonastali 

CreateCylinder promijeniti polumjer šipke u stupcu Radius na 4 mm, a visinu u stupcu Height 

postaviti na 590 mm, te mu postaviti koordinate prikazane slikom 5.60. 

 

Slika 5.60. Parametri u CreateCylinder za Cylinder2 

 Nakon toga potrebno je kopirati taj oblik devet puta sa međusobnim razmacima od 70 milimetara. 

To se može postići desnim klikom na stvorenu šipku i odabiranjem opcije Edit → Duplicate → 

Along Line nakon čega se bira razmak od 70 mm između šipki u X smjeru (potrebno je držati slovo 

X na tipkovnici), te broj šipki koji se želi stvoriti, što je u ovom slučaju devet (slika 5.61.).  
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Slika 5.61. Odabir broja kopiranih šipki 

Potrebno je napraviti još jednu šipku pomoću naredbe Draw Cylinder, ali ovoga puta u YZ ravnini. 

Nakon stvaranja šipke, dvostrukim klikom na novonastali CreateCylinder promijeniti polumjer 

šipke u stupcu Radius na 4 mm, a visinu u stupcu Height postaviti na 590 mm, te mu postaviti 

koordinate prikazane slikom 5.62. 

 

Slika 5.62. Parametri u CreateCylinder za Cylinder3 

Nakon što je napravljena rešetka potrebno je ujediniti šipke držanjem tipke Ctrl na tipkovnici i 

lijevim klikom miša na svaku šipku kako bi se odabrale sve šipke. Nakon što je rešetka označena 

desnim klikom se odabire opcija Edit → Boolean → Unite. Materijal od kojeg je rešetka 

napravljena treba promijeniti u željezo postupkom koji je ranije već objašnjen. Potrebno je još 

napraviti prostor u kojem će se nalaziti rešetka u betonu. Prvo treba označiti beton lijevim klikom 

miša, a zatim držati tipku Ctrl i označiti rešetku. Desnim klikom odabrati opciju Edit → Boolean 



 

53 

→ Substract čime se otvara novi prozor na kojem je potrebno staviti kvačicu na opciju Clone tool 

objects before operation, kako se ne bi izbrisala rešetka i stisnuti OK (slika 5.63.). 

 

Slika 5.63. Oduzimanje naredbom Substract 

Potrebno je napraviti i preostalih pet rešetki na gore opisan način, te odraditi njihovu simulaciju 

naredbom Analyze all. 

 

 

Slika 5.64. Armirani beton sa dimenzijom rešetke 70x70, debljina 8 mm 
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Slika 5.65. Armirani beton sa dimenzijom rešetke 100x100, debljina 8 mm 

 

 

Slika 5.66. Armirani beton sa dimenzijom rešetke 140x140, debljina 8 mm 
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Slika 5.67. Model simulacije za dva konusna dipola sa preprekom od armiranog betona  

5.7. Rezultati simulacije zračenja dva konusna dipola s preprekom od 

armiranog betona 

Koeficijente transmisije S21, te koeficijente refleksije S11 moguće je prikazati desnim klikom na 

Results i odabirom opcije Create Modal Solution Data Report → Rectangular Plot čime se otvara 

novi prozor na kojem je potrebno na mjestu Category odabrati S Parameter, na Quantity odabrati 

parametar S21, odnosno S11, a na mjestu Function odabrati dB i stisnuti New Report. 
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Slika 5.68. Koeficijent transmisije S21 kroz prepreku od armiranog betona sa dimenzijom rešetke 

70x70, debljine 8 mm (crvena krivulja) i beton (plava krivulja) u frekvencijskom opsegu 1-2 GHz 

Na slici 5.68 prikazana je usporedba koeficijenata transmisije S21 kroz beton (plava krivulja) i 

armirani beton (crvena krivulja). Moguće je uočiti da će na većini simuliranog frekvencijskog 

područja koeficijent transmisije biti malo bolji za običan beton iz razloga što su kod armiranog 

betona dodane željezne šipke koje imaju relativno dobru vodljivost pa stoga apsorbiraju određeni 

dio energije. Dodavanjem željezne rešetke u beton promijenila se frekvencija na kojoj se nalazi 

maksimalna vrijednost koeficijenta transmisije S21 s 1.91 GHz na 1.59 GHz.  

 

Slika 5.69. Koeficijent refleksije S11 konusnog dipola s preprekom od armiranog betona s 

dimenzijom rešetke 70x70, debljine 8 mm (plava krivulja) i 10 mm (crvena krivulja) u 

frekvencijskom opsegu 1-2 GHz 

Na slici 5.69. prikazani su koeficijenti refleksije S11 u slučaju kada se između konusnih dipola 

nalazi prepreka od armiranog betona, sa dimenzijama rešetke 70x70, pri čemu je rešetka debljine 

8 mm prikazana plavom, a rešetka debljine 10 mm crvenom krivuljom. Moguće je uočiti da će 

konusni dipol za oba slučaja najbolje raditi na frekvenciji od 1.67 GHz, kada će koeficijent 

refleksije za rešetku debljine 8 mm iznositi -46.9 dB, dok će za rešetku debljine 10 mm koeficijent 

refleksije biti nešto veći i iznosit će -37.85 dB. 
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Slika 5.70. Koeficijent transmisije S21 kroz prepreku od armiranog betona sa dimenzijom rešetke 

70x70, debljine 8 mm (plava krivulja) i 10 mm (crvena krivulja) u frekvencijskom opsegu 1-2 

GHz 

Na slici 5.70. nalaze se koeficijenti transmisije S21 kroz prepreku od armiranog betona, sa 

udaljenošću između šipki koja iznosi 70 mm, te debljinama šipki od 8 mm (plava krivulja) i 10 

mm (crvena krivulja). Može se uočiti da će na frekvencijama manjim od 1.35 GHz koeficijent 

transmisije biti bolji za beton sa tanjim šipkama, dok će na frekvencijama većim od 1.6 GHz biti 

obrnuto. Na frekvencijama između 1.35 i 1.6 GHz koeficijenti transmisije su dosta slični, i na tom 

području su najviši za oba slučaja. Vidljivo je da će promjena debljine rešetke imati blag utjecaj 

na frekvenciju na kojoj se nalazi maksimalna vrijednost koeficijenta transmisije. Za armirani beton 

sa rešetkom debljine 8 mm maksimalan koeficijent transmisije iznosi -26.61 dB, dok za armirani 

beton sa rešetkom debljine 10 mm iznosi -26.33 dB. Oznake m3 i m4 na slici prikazuju koeficijente 

transmisije na frekvenciji gdje je koeficijent refleksije najmanji, odnosno frekvenciju na kojoj 

konusni dipol najbolje zrači. Vidljivo je da se ona razlikuje od frekvencije na kojoj se nalazi 

maksimalni koeficijent transmisije. 
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Slika 5.71. Koeficijent refleksije S11 konusnog dipola s preprekom od armiranog betona s 

dimenzijom rešetke 100x100, debljine 8 mm (plava krivulja) i 10 mm (crvena krivulja) u 

frekvencijskom opsegu 1-2 GHz 

Slika 5.71. prikazuje koeficijente refleksije za konusne dipole kada se između njih nalazi prepreka 

od armiranog betona dimenzije 100x100, pri čemu je koeficijent refleksije S11 kod rešetke debljine 

8 mm predstavljen plavom krivuljom, a kod rešetke debljine 10 mm crvenom krivuljom. Kao i kod 

rešetke dimenzije 70x70, koeficijent refleksije je dosta sličan na simuliranom frekvencijskom 

području, ali armirani beton sa manjom debljinom rešetke ima manji minimum koji iznosi -48.48 

dB, dok minimum kod armiranog betona s većom debljinom rešetke iznosi -42.65 dB. 
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Slika 5.72. Koeficijent transmisije S21 kroz prepreku od armiranog betona sa dimenzijom rešetke  

100x100, debljine 8 mm (plava krivulja) i 10 mm (crvena krivulja) u frekvencijskom opsegu 1-2 

GHz 

Slika 5.72. prikazuje koeficijente transmisije za prepreku od armiranog betona sa dimenzijama 

rešetke 100x100 mm, debljine 8 mm (plava krivulja) i 10 mm (crvena krivulja). Moguće je uočiti 

da su koeficijenti transmisije veoma slični duž prikazanog frekvencijskog spektra, te da će beton 

sa tanjim šipkama u prosjeku imati malo bolje koeficijente transmisije. Konusni dipol će za beton 

s debljinom rešetke 8 mm najbolje raditi na frekvenciji od 1.59 GHz kada će koeficijent transmisije 

S21 iznositi -27.71 dB, a za beton s rešetkom debljine 10 mm najbolje će raditi na frekvenciji od 

1.6 GHz pri čemu koeficijent transmisije iznosi -27.68 dB. 

 

Slika 5.73. Koeficijent refleksije S11 konusnog dipola s preprekom od armiranog betona s 

dimenzijom rešetke 140x140, debljine 8 mm (plava krivulja) i 10 mm (crvena krivulja) u 

frekvencijskom opsegu 1-2 GHz 

Na slici 5.73. nalaze se koeficijenti refleksije S11 za armirani beton sa dimenzijom rešetke 

140x140, pri čemu plava krivulja označava koeficijent refleksije za rešetku debljine 8 mm, a 

crvena krivulja predstavlja koeficijent refleksije za rešetku debljine 10 mm. Za razliku od 

prethodnih slučajeva s armiranim betonom gdje je rešetka s manjom debljinom imala manji 

minimum koeficijenta refleksije, ovdje su minimalni koeficijenti refleksije jako slični i iznose -

39.09 dB za rešetku s manjom debljinom, i -39.16 dB za rešetku s većom debljinom. 
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Slika 5.74. Koeficijent transmisije S21 kroz prepreku od armiranog betona sa dimenzijom rešetke 

140x140, debljine 8 mm (plava krivulja) i 10 mm (crvena krivulja) u frekvencijskom opsegu 1-2 

GHz 

Na slici 5.74. nalaze se koeficijenti transmisije kroz armirani beton, pri čemu su šipke rešetke 

međusobno udaljene 140 mm, sa debljinom šipke 8 mm (plava krivulja) i 10 mm (crvena krivulja). 

Kao i u prethodna dva slučaja, moguće je uočiti da je koeficijent transmisije S21 ostaje dosta sličan 

duž simuliranog frekvencijskog spektra kada se promijeni debljina rešetke. Konusni dipoli će za 

obje debljine šipki raditi najbolje na frekvenciji od 1.6 GHz, pri čemu će koeficijent transmisije za 

debljinu od 8 mm iznositi -26.85 dB, a za debljinu od 10 mm iznosit će -26.89 dB. 
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Slika 5.75. Koeficijent transmisije S21 kroz prepreku od armiranog betona sa dimenzijama 

rešetke 70x70 (crvena krivulja), 100x100 (plava krivulja) i 140x140 (smeđa krivulja), i 

debljinom rešetke 8 mm u frekvencijskom opsegu 1-2 GHz 

Slika 5.75. prikazuje usporedbu koeficijenata transmisije S21 kroz armirani beton pri različitim 

dimenzijama rešetke, pri čemu je debljina rešetke 8 mm. Moguće je uočiti da će promjena 

dimenzije rešetke imati veći utjecaj na koeficijente transmisije od promjene debljine rešetke. 

Frekvencija na kojoj će koeficijenti transmisije biti maksimalni ostaje približno jednaka pri 

promjeni dimenzije rešetke, te iznosi 1.59 ili 1.6 GHz. 

 

Slika 5.76. Koeficijent transmisije S21 kroz prepreku od armiranog betona sa dimenzijama 

rešetke 70x70 (crvena krivulja), 100x100 (plava krivulja) i 140x140 (smeđa krivulja), i 

debljinom rešetke od 10 mm u frekvencijskom opsegu 1-2 GHz 

Na slici 5.76. prikazana je usporedba koeficijenata transmisije S21 kroz armirani beton sa različitim 

dimenzijama željezne rešetke, pri čemu debljina rešetke iznosi 10 mm. Moguće je uočiti da će u 

ovom slučaju za sve tri dimenzije rešetke konusni dipoli najbolje zračiti na frekvenciji od 1.6-1.61 

GHz. 

Frekvencija [GHz] 1 1.2 1.4 1.6 1.8 2 

Minimalna 

vrijednost 

(frek. u GHz) 

S11 – bez prepreke [dB] -10.46 -12.13 -16.78 -29.62 -23.69 -16.46 -30.48 (1.63) 

S11 – beton [dB] -10.27 -12.53 -18.39 -30.37 -26.88 -16.36 -33.31 (1.67) 
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S11 – armirani beton 

70x70, 8 mm [dB] 
-10.17 -12.96 -17.49 -28.81 -25.49 -17.93 -46.90 (1.67) 

S11 – armirani beton 

70x70, 10 mm [dB] 
-10.08 -13.06 -17.70 -29.51 -24.70 -17.84 -37.85 (1.67) 

S11 – armirani beton 

100x100, 8 mm [dB] 
-10.26 -12.61 -17.53 -32.57 -24.46 -17.29 -48.48 (1.68) 

S11 – armirani beton 

100x100, 10 mm [dB] 
-10.23 -12.64 -17.72 -32.68 -23.76 -17.64 -42.65 (1.68) 

S11 – armirani beton 

140x140, 8 mm [dB] 
-10.25 -12.62 -17.85 -31.66 -25.46 -18.59 -39.09 (1.67) 

S11 – armirani beton 

140x140, 10 mm [dB] 
-10.27 -12.62 -17.69 -30.16 -24.90 -18.25 -39.16 (1.68) 

 

Tablica 5.1. Prikaz rezultata simulacije za koeficijente refleksije S11 za konusne dipole u 

slobodnom prostoru, te u slučajevima sa preprekom od betona, odnosno armiranog betona 

Frekvencija 

[GHz] 
1 1.2 1.4 1.6 1.63 1.8 2 

Maksimalna 

vrijednost 

(frek. u GHz) 

S21 – bez 

prepreke [dB] 
-29.34 -31.35 -30.36 -27.68 -27.38 -26.51 -27.5 -26.5 (1.82) 

S21 – beton 

[dB] 
-30.78 -31.27 -31.4 -26.82 -27.78 -28.56 -28.86 -26.41 (1.91) 

S21 – armirani 

beton  70x70, 8 

mm [dB] 

-31.87 -35.39 -29.89 -26.73 -27.79 -29.45 -31.71 -26.61 (1.59) 

S21 – armirani 

beton  70x70, 

10 mm [dB] 

-31.84 -36.28 -29.65 -26.34 -26.7 -29.18 -31.76 -26.33 (1.61) 

S21 – armirani 

beton  

100x100, 8 mm 

[dB] 

-31.02 -33.33 -32.29 -27.76 -29.69 -28.22 -34.55 -27.71 (1.59) 
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S21 – armirani 

beton  

100x100, 10 

mm [dB] 

-30.87 -33.39 -32.46 -27.68 -29.11 -28.19 -33.11 -27.68 (1.6) 

S21 – armirani 

beton  

140x140, 8 mm 

[dB] 

-31.39 -34.07 -30.47 -26.86 -27.8 -29.11 -29.05 -26.85 (1.6) 

S21 – armirani 

beton  

140x140, 10 

mm [dB] 

-31.22 -34.26 -30.55 -26.90 -27.88 -28.73 -29.51 -26.88 (1.6) 

 

Tablica 5.2. Prikaz rezultata simulacije za koeficijente transmisije S21 za konusne dipole u 

slobodnom prostoru, te u slučajevima sa preprekom od betona, odnosno armiranog betona 
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6. ZAKLJUČAK 

Zadatak završnog rada je određivanje apsorpcije elektromagnetskog zračenja pri prolasku vala 

kroz armirani beton u frekvencijskom opsegu od 1 do 2 GHz. Zadatak je odrađen u računalnom 

programu Ansys 2022 R1. 

Najprije je simuliran konusni dipol u slobodnom prostoru, gdje su određeni koeficijent refleksije 

S11, odnos stojnog vala VSWR, ulazna impedancija i dijagram zračenja. Simulacija je odrađena u 

frekvencijskom opsegu 0.5-5 GHz kako bi se prikazalo cijelo područje rada konusnog dipola. 

Promatrajući rezultate simulacije utvrđeno je da će konusni dipol najbolje raditi na frekvenciji od 

2.63 GHz kada je koeficijent refleksije najmanji te iznosi -36.24 dB. U frekvencijskom opsegu 1-

2 GHz, koji se u radu ispituje, konusni dipol će najbolje raditi na frekvenciji od 1.63 GHz kada 

koeficijent refleksije iznosi -30.48 dB, a odnos stojnog vala VSWR, koji je funkcija koeficijenta 

refleksije, iznosi 1.06. Impedancija antene na ovoj frekvenciji je 52.75 - j1.38 Ω, što je približno 

impedanciji na koju se antena prilagođava. 

Nakon simulacije konusnog dipola u slobodnom prostoru napravljen je još jedan konusni dipol sa 

istim dimenzijama kao i prvi te su simulirani koeficijenti transmisije S12 i S21, te koeficijent 

refleksije S22. Rezultati simulacije su pokazali da će konusni dipoli u slobodnom prostoru najbolje 

raditi na frekvenciji od 1.82 GHz kada koeficijent transmisije iznosi -26.5 dB. Rezultati također 

pokazuju da su koeficijenti transmisije S21 i S12 jednaki, što je i očekivano budući da se koriste iste 

antene. 

Napravljen je betonski blok te su ponovno simulirani koeficijenti refleksije S11, te koeficijenti 

transmisije S12 i S21. Rezultati simulacije su uspoređeni sa koeficijentima transmisije u slobodnom 

prostoru, te pokazuju da će na većini simuliranog frekvencijskog područja koeficijenti transmisije 

biti manji nego u slobodnom prostoru, što govori da će beton apsorbirati određeni dio energije. 

Vidljivo je da će maksimum koeficijenta transmisije za beton iznositi -26.41 dB na frekvenciji od 

1.91 GHz, što se razlikuje od frekvencije 1.82 GHz, na kojoj se nalazi maksimum koeficijenta 

transmisije za slobodni prostor. Dio vala koji se reflektira od betona djeluje na odaslane valove iz 

antene čime dolazi do promjene koeficijenata transmisije, a samim tim i frekvencije na kojoj se 

nalazi najveća vrijednost koeficijenta transmisije. Reflektirani val na određenim frekvencijama 

može djelovati konstruktivno na odaslane valove ako je u fazi sa odaslanim valom, što može 

objasniti više koeficijente transmisije kod betona nego kod slobodnog prostora na nekim 

frekvencijama. 
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U beton je stavljeno šest željeznih rešetki različitih dimenzija i debljine kako bi se provjerio njihov 

utjecaj na koeficijente refleksije i transmisije. Rezultati su pokazali da će koeficijenti transmisije 

na većini promatranog frekvencijskog opsega biti manji nego kod ostalih slučajeva iz razloga što 

željezne šipke unutar betona imaju dobru vodljivost pa mogu apsorbirati dio energije vala. 

Frekvencija na kojoj se nalazi maksimalna vrijednost koeficijenta transmisije se promijenila u 

odnosu na beton i slobodni prostor i nalazi se na frekvencijskom opsegu od 1.59-1.61 GHz, ovisno 

o dimenziji i debljini armature. Utvrđeno je da promjenom debljine rešetke koeficijent transmisije 

ostaje jako sličan duž simuliranog frekvencijskog opsega, u smislu da se oblik krivulje grafa 

gotovo ne mijenja, a vrijednosti na jednakim frekvencijama se ne razlikuju više od 4 dB, a 

uglavnom je razlika u 0.1-1 dB.  Promjena dimenzije rešetke više utječe na oblik krivulje na grafu, 

vrijednosti na jednakim frekvencijama se razlikuju i do 11 dB, dok se na većini simuliranih 

frekvencija razlikuju za 2-4 dB. 
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SAŽETAK 

U ovom radu je prikazana konstrukcija i simulacija zračenja između dva konusna dipola između 

kojih se nalazi prepreka od armiranog betona. Simulacija je izvedena u programu Ansys 2022 R1. 

U radu su opisani svi koraci konstrukcije modela konusnog dipola, betonskog bloka, te bloka 

armiranog betona. Simulirani su i opisani koeficijent refleksije S11, dijagram zračenja, odnos 

stojnog vala VSWR i ulazna impedancija za konusni dipol u slobodnom prostoru, te parametri 

transmisije S12 i S21 za dva konusna dipola u slobodnom prostoru, te u slučaju kada se između njih 

nalazi beton, odnosno armirani beton. 

Ključne riječi: elektromagnetski val, Maxwellove jednadžbe, antene, dipol, zračenje, ansys HFSS, 

simulacija, koeficijent refleksije S11, VSWR,  koeficijenti transmisije S12 

ABSTRACT 

This paper describes construction and simulation of radiation between two biconical dipoles with 

an obstacle of reinforced concrete. Simulation is done in the program Ansys 2022 R1. This paper 

describes all of the steps needed to construct the model of biconical dipole, concrete block and 
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reinforced concrete block. The results of reflection coefficient S11, radiation pattern, voltage 

standing vawe ratio VSWR and input impedance for biconical dipole in open space, as well as 

transmission coefficients S12 and S21 for two biconical dipoles in open space, as well as when there 

is concrete and reinforced concrete in between them were all simulated and described. 

Key words: electromagnetic vawe, Maxwell's equations, antennas, dipole, radiation, ansys HFSS, 

simulation, reflection coefficient S11, VSWR, transmission coefficient S12 

 


